Reason 11

Installation Manual
Table of Contents
Introduction 7

Welcome! 8

About the Reason documentation 8

About operating system versions 8

What is in the Reason box? 8
Product authorization 8

The Reason download version 9

Installation 11

Requirements 12
macOS 12
Windows 12

About the Audio Hardware 13
Audio hardware and macOS 13
  If you are using the Propellerhead Balance audio interface 13
  If you are using the built-in audio hardware in your Macintosh 13
  If you are using other audio hardware with your Macintosh 13
Audio hardware and Windows 13
  If you are using the Propellerhead Balance audio interface 13
  If you are using other audio hardware with your Windows PC 14

About MIDI Interfaces 14
MIDI In Connections 14
MIDI Out Connections 15

Installing the Software 15
Installing Reason 15
The Authorization system 16
Registering Reason 16
Running Reason with Internet Verification 17
Authorizing your Computer/Ignition Key (for off-line use) 18
About deauthorizing the computer/Ignition Key 19
Running Reason on an authorized computer - or with an authorized Ignition Key 19
Running Reason in Demo Mode 20
Setting Up 21

About this Chapter 22

First run - Reason Setup Wizard 22

About the Preferences 24
Setting up the Audio Hardware 25
macOS 26
Windows 26
About Latency and other Audio Settings 26

Setting up MIDI Control Surfaces 27
Automatic set-up using the Easy MIDI Inputs function 27
Adding a specific Control surface 28
If your control surface model isn’t listed 31
About the Master Keyboard 31
Master Keyboard Input 32
Other functions 32

Setting up the Default Song 33
Opening the last Song at program launch 33

Reassigning the Function Keys in macOS 34
Chapter 1
Introduction
Welcome!

Thank you for choosing Reason!

Reason 11 comes with a number of workflow enhancements in the sequencer, such as curved automation, multiple notes drawing and muting of individual notes – plus crossfading of audio clips. We also added two new audio modulation effects – plus three mixer channel strip rack devices, that are now additionally available as Rack effect devices.

Reason 11 also lets you use the Reason Rack as a plugin in another compatible DAW.

Don’t forget to visit the Reason Studios web site at www.reasonstudios.com and read up on all the new Rack Extension instruments and effects created by ourselves and others that you can add to your rack.

Yours truly,
The Reason Studios Team
www.reasonstudios.com

About the Reason documentation

This is the Installation Manual where installation of Reason and basic setting up procedures are described. Detailed features and operations in Reason are described in the Operation Manual pdf and in the on-line Help system. The Operation Manual and Help also contain reference descriptions of all Reason devices and commands.

About operating system versions

Reason runs under macOS and Windows (for operating system details, see “Requirements”) and only supports 64-bit operating system versions. All Reason packages contain program versions for both platforms. Everything said in the manuals applies to both platforms, unless explicitly stated.

What is in the Reason box?

If you have purchased the boxed version of Reason, the package contains the following item:

Product authorization

The license number and registration code required for the installation are printed on the insert in the box. The registration code is a one-time code used to register your Reason license to your Reason Studios user account. Once you have registered Reason to your account and, you don’t need the registration code any more. In the box is also a link to the Reason download section on the Reason Studios web site.

Note that if you bought Reason from the Reason Studios web shop, it has already automatically been registered to your account.
The full download version of Reason contains the complete product contents. In other words, there is no need to purchase a boxed version. When you have downloaded the program package and installed the program, all you have to do is register and authorize the program and you are good to go. Refer to “Registering Reason” and “Running Reason with Internet Verification” for details.
Chapter 2
Installation
Requirements

Below you will find the minimum requirements for running Reason:

! Note that these are the minimum requirements! You will benefit from a fast computer with lots of RAM, since this will allow you to use more devices at the same time.

macOS

- Fast and stable Internet connection for installation and registration required!
- Intel Mac with multi-core processor
- 4 GB RAM (8 GB or more recommended for large ReFills or Rack Extensions)
- 4 GB free system disk space required, plus 8 GB for optional content (and another 12 GB if you are using Reason Suite). Additionally, the program may use up to 20 GB scratch disk space
- macOS 10.11 (El Capitan) or later (64-bit)
- Monitor with at least 1280x768 resolution
- CoreAudio compliant audio interface or built-in audio hardware
- MIDI interface and a MIDI keyboard recommended
- For using Reason as a VST Plugin, a DAW host with VST3 and/or AUv2 support is required

Windows

- Fast, stable Internet connection for installation and registration required!
- Intel or AMD multi-core processor
- 4 GB RAM (8 GB or more recommended for large ReFills or Rack Extensions)
- 4 GB free system disk space required, plus 8 GB for optional content (and another 12 GB if you are using Reason Suite). Additionally, the program may use up to 20 GB scratch disk space
- Windows (7)/8/10 (64-bit)
- Monitor with at least 1280x768 resolution
- Audio Interface with ASIO driver
- MIDI interface and a MIDI keyboard recommended
- For using Reason as a VST Plugin, a DAW host with VST3 support is required
About the Audio Hardware

! If you are running Reason Rack Plugin, all audio inputs and outputs are handled by the DAW host - refer to the manual for your specific DAW.

The audio hardware is the computer equipment that converts the analog signals from instruments and microphones to digital signals that Reason can work with and store, and back again (for connection to an amplifier, headphones, or similar). This equipment could be a built-in audio card, a 2 channel USB interface, such as Propellerhead Balance, or a Firewire audio interface, or an audio card with several inputs and outputs, digital connectors, etc. Regardless of which, you need to make sure the hardware and its drivers are properly installed:

Audio hardware and macOS

If you are using the Propellerhead Balance audio interface
Please refer to the Propellerhead Balance Operation Manual pdf for information on how to install, connect and use the Propellerhead Balance audio interface.

If you are using the built-in audio hardware in your Macintosh
All Mac models come with a built-in audio interface, providing stereo input and output jacks (and in some cases a built-in microphone). Depending on your needs, the quality of these inputs and outputs may be fully sufficient for use with Reason.

If you are using other audio hardware with your Macintosh
You may want to use other audio hardware with Reason (e.g. an audio interface with multiple outputs, digital connections, etc.). For this to be possible, the audio hardware must be compatible with macOS, i.e. there must be a Core Audio driver available for the hardware.

1. Install the audio hardware drivers as described in its documentation.
   Note that some audio hardware does not require any special audio drivers. Please, refer to the hardware documentation.

2. Connect the stereo outputs of your audio hardware to your listening equipment (speakers, mixer, headphones or similar).
   For info about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual pdf. For now, we stick to standard stereo connections.

3. If possible, test that audio plays back OK with the audio hardware.
   With some audio hardware, a test application is supplied for this purpose.

Audio hardware and Windows

If you are using the Propellerhead Balance audio interface
Please refer to the Propellerhead Balance Operation Manual pdf for information on how to install, connect and use the Propellerhead Balance audio interface.
If you are using other audio hardware with your Windows PC

! To run Reason with full audio in and audio out functionality under Windows, an ASIO driver is required for the audio hardware.

Reason can run with DirectX or MME drivers as well but this will only support audio out - and at considerably higher latencies than with ASIO drivers.

1. **Make sure you have the latest ASIO driver for the audio hardware!**
   Please check the manufacturer’s web site for the latest versions.

2. **Install the audio hardware drivers as described in its documentation.**

3. **Connect the stereo outputs of your audio hardware to your listening equipment (speakers, mixer, headphones or similar).**
   For information about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual pdf. For now, we stick to standard stereo connections.

4. **If possible, test that audio plays back properly with the audio hardware.**
   In the case of audio hardware with ASIO drivers, you will need some test application for this (often included with the audio hardware).

### About MIDI Interfaces

While it is possible to use Reason without an external MIDI controller (by only using the "On-screen Piano Keys" window for playing MIDI notes, or by manually drawing notes and automation in the sequencer), this would not allow you to use the program to its full potential. From now on we assume that you are using a keyboard controller – either a USB keyboard with a built-in MIDI interface, or a separate MIDI interface and a MIDI keyboard.

- **When installing the keyboard controller, or MIDI interface and its drivers, follow the instructions in its documentation carefully.**

  - **While a MIDI interface with a single MIDI port is sufficient, you will benefit from having two or more individual MIDI ports.**
    This is especially true if you want to manipulate Reason parameters with additional MIDI control surface devices, or use the program in conjunction with an external, stand-alone sequencer, drum machine or similar.

  - **For some MIDI interfaces connected via USB, no driver installation is required. Just plug in the interface and you’re ready to go!**

  - **For other, more advanced MIDI interfaces (or at least to take advantage of more advanced features, like multiple inputs) you will need to install a driver.**
    Please consult the documentation that came with the interface for details.

### MIDI In Connections

- **Simply connect the USB cable from your keyboard to your computer.**

  Or

- **Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI controller) to a MIDI In on your MIDI interface.**
  This is sufficient to be able to play and record notes and controllers in Reason from the MIDI keyboard.
- If you are not using a USB keyboard, you may also connect the MIDI Out from the MIDI interface to the MIDI In on your MIDI keyboard.
  This is not strictly necessary to use Reason, but it will enable two-way communication when you run the Reason Setup Wizard which appears the first time Reason is launched (see "First run - Reason Setup Wizard"), or when using Auto-detect Surfaces in the Preferences (see "Adding a specific Control surface"). Whether auto-detection works or not depends on the keyboard model.

  ! If you have several MIDI control surfaces or similar that you want to use, we recommend that you connect them to separate MIDI ports (or directly to the computer using USB).

### MIDI Out Connections

If you have external synthesizers, drum machines or other devices that can be played via MIDI, you can control them from Reason. For this you need to have a MIDI interface with one or several outputs.

- **Connect a MIDI cable from a MIDI Out jack on the MIDI interface to the MIDI In jack on your external instrument.**
  
  Read more about how to control external MIDI devices from Reason in the Reason Operation Manual.pdf or Reason Help in the program.

### Installing the Software

! Both the stand-alone version of Reason and the Rack Plugin are installed in the same procedure. So, even if you are only planning to use the Rack Plugin version of Reason, follow the installation procedure(s) below:

#### Installing Reason

- **Unzip the download file (Windows) or mount the disk image file (macOS).**
  
  What to do next depends on whether you are installing on a Mac or a Windows computer.

  **Windows:**
  1. Locate the file called “Install Reason 11.exe” and double click it.
  2. Follow the instructions on screen.

  Before executing the installation of the software components, you will be asked to select a language, an install location, and whether you wish to create a program shortcut/alias on your desktop. When the installation is complete, you have the option of launching Reason directly.

  The Reason Rack Plugin VST3 is automatically installed in `C:\Program Files\Common Files\VST3`.

  **macOS:**
  1. Double click the Reason installation file.
  2. Follow the instructions on screen.

  The Reason Rack Plugin VST3 is automatically installed in `Macintosh HD/Library/Audio/Plug-Ins/VST3`.

  The Reason Rack Plugin AUv2 is automatically installed in `Macintosh HD/Library/Audio/Plug-Ins/Components`. 
Both platforms:

- **During the installation, the Authorizer application will be installed on your computer.**
  This application is necessary for handling the Reason authorization (see below) and administration of Rack Extension devices.

- **At the first program launch, you will also have the option to download additional content from the Manage Content window.**
  The optional content consists of Rack Extensions and sound banks and is stored in the “Propellerhead Content” folder in the “Music” folder on your computer. After the download you will have to restart Reason for the optional content to become available.

**The Authorization system**

Reason uses an authorization system designed to be as flexible as possible, while at the same time providing the best possible copy protection for the product. Here’s how it works:

- **The core of the authorization system is your license number, which is registered to your user account on the Reason Studios web site.**

- **If you have a working Internet connection you can run Reason with Internet Verification.**
  The program will then contact the Reason Studios web site and verify that Reason is registered to your user account.

- **If you need to use Reason without Internet access, you can download and install the CodeMeter application and then authorize your computer (or Ignition Key hardware) from your Reason Studios user page.**
  During start-up Reason automatically detects that your computer is authorized.

- **Finally, if you don’t have a working Internet connection, or any authorized computer or Ignition Key hardware, you can run Reason in Demo Mode (the stand-alone Reason version only).**
  This is also the mode you use if you are trying out the program, but haven’t yet purchased it. In Demo Mode you can work as usual and even save your work. However, you cannot open songs in Demo Mode (for details, see “Running Reason in Demo Mode”).

  ! **Note that the same authorization is used both for the stand-alone Reason version and for Reason Rack Plugin.**

**Registering Reason**

To be able to run Reason in authorized mode (see “Running Reason with Internet Verification” and “Running Reason on an authorized computer - or with an authorized Ignition Key”), the program must be registered to your account on the Reason Studios web site.

- **If you purchased the boxed version of Reason, follow the instructions printed on the insert.**

  ! **If you purchased Reason directly from the Reason Studios web shop, the Reason license has already been registered to your user account and you can use Reason by running with Internet Verification.**
Running Reason with Internet Verification

When you launch Reason on an unauthorized computer, or without an authorized Ignition Key hardware connected, the following window appears:

! Note that this requires a working Internet connection (and that your Reason license has been registered to your user account as described in “Registering Reason”).

» Enter the User name and Password for your Reason Studios account and click the Log in button. Reason now launches in authorized mode.

» If you click “Remember my password” in the dialog, creating the first Reason Rack Plugin instance in a DAW will make Reason Rack Plugin launch silently in the background (without any log-in dialog).

! It is not possible to run two instances of Reason (on different computers) authorized to the same user account. Reason will then enter Demo Mode (see “Running Reason in Demo Mode”).
Authorizing your Computer/Ignition Key (for off-line use)

! Note that a working Internet connection is required to be able to perform the following steps.

1. **Launch Reason.**
   When you start Reason the following window appears:

![Welcome to Reason!](image)

2. **Click on the “More Options” link.**
   Your default web browser starts up and takes you to the More Options page on the Reason Studios web site, where the whole authorization process is described in detail.

3. **Follow the link on the web page to download and install CodeMeter.**
   If you are updating from a previous version of Reason, you may already have CodeMeter installed on your computer. However, it's a good idea to download and install the latest version of the CodeMeter driver.

4. **When done, return to the More Options page and click the Authorize Computer and Keys link.**

5. **When you launch Reason again, you will be able to run the program in Authorized mode, without having to log in.**
   You can now quit the web browser if you like.
About deauthorizing the computer/Ignition Key

You can have one computer and one Ignition Key authorized at a time. If you’re moving your work from an authorized computer to another computer, you should first deauthorize the current computer and then authorize the other one. This is done from your account page at the Reason Studios web site:

1. **Log in on your currently authorized computer and go to your own "Products" page under the user menu.**

2. **Click the Authorize button.**
   On the page that is shown, there should be a Deauthorize button next to the computer icon.

3. **Click the Deauthorize button next to the computer icon to remove the authorization from your computer.**

   If you are using an authorized Ignition Key instead of an authorized computer, you can just move the Ignition Key from your old computer to your new one.

   ! Remember to deauthorize your computer before updating the Operating System or before sending your computer to service or selling it!

Running Reason on an authorized computer - or with an authorized Ignition Key

If you launch Reason on an authorized computer, or with an authorized Ignition Key (Reason Studios USB stick) connected, the program will simply start without further ado.

➤ If you are using an Ignition Key on an unauthorized computer, always connect the Ignition Key before starting your computer and launching Reason. This way Reason will start up immediately, without the Authorization procedure.

If you have an authorized computer, or an authorized Ignition Key connected to your computer, it's no longer necessary to have Internet connection when running Reason.
Running Reason in Demo Mode

! Demo Mode is only available in the stand-alone version of Reason not in Reason Rack Plugin.

If you don't have a Reason license, or if you don't have an authorized computer or your optional Ignition Key at hand and don't have a working Internet connection, you can run Reason in Demo Mode:

1. Launch Reason.
The following window shows up:

2. Click the "Demo Mode" button.
Reason launches in Demo Mode.
The Demo Mode indicator lights up to the right on the Sequencer Transport Panel:

Running Reason in demo mode allows you to perform all operations as in authorized mode, with three exceptions:

- **You cannot export audio or bounce mixer channels to disk.**
- **You will not have access to any Rack Extension devices (except for the included Radical Piano, Synchronous, Softube Amps, Audiomatic and Pulsar Rack Extensions).**
- **You cannot open songs.**
The only songs that can be opened in demo mode are the dedicated demo songs (file extensions ".rsndemo" (Reason Demo Song), ".reedemo" (Reason Essentials Demo Song), ".reidemo" (Reason Demo Song), ".reltdemo" (Reason Lite Demo Song) and ".recdemo" (Record Demo Song)). Demo songs can be accessed from the “Open Demo Song” item in the File menu.

If you disconnect your Ignition Key on an unauthorized computer, or lose the Internet Connection while running Reason with Internet Verification, the program will automatically enter Demo Mode. You can continue to work, and save your songs as usual. When you reconnect the Ignition Key hardware or reconnect to the Internet, Reason will automatically revert to authorized mode and the Demo Mode indicator will go off.
Chapter 3
Setting Up
About this Chapter

This chapter is only relevant for the stand-alone version of Reason. For Reason Rack Plugin, no further setup is needed as the host DAW handles audio and MIDI connections.

This chapter describes the settings you need to make before you can start using the stand-alone version of Reason. These are necessary in order to get any sounds to and from the program and to be able to play and control Reason via MIDI.

First run - Reason Setup Wizard

If you followed the instructions correctly in the last chapter, Reason should be running, and the first dialog in the “Reason Setup Wizard” guide should be open.

This only appears the very first time the program is run.

![Reason Setup Wizard](image)

Note that the Language page only appears in the Windows version of Reason. In macOS, the selected system language is used.

Note that any setting you make in the Setup Wizard can be changed later on in the Preferences dialog.
Clicking “Next” will take you through a series of dialogs, where the following happens:

- **The Setup Wizard will first try to find a compatible audio driver.**
  It will automatically select the first compatible driver it finds. If this is the driver you wish to use, fine. If it isn’t, select your preferred driver from the Audio Card Driver pop-up. If you don’t know which driver to use, see “Setting up the Audio Hardware”.

- **Next, Reason will try to auto-detect a Master Keyboard.**
  If one is found, click "Next!" to proceed.

  ! **For Reason to auto-detect a device you need two-way MIDI communication!** Non-USB keyboard devices without a MIDI input can of course still be added manually.

  ! **Note that your keyboard model might not be auto-detected by Reason, even though it’s a modern one and connects via USB. However, you can still use such a keyboard to control Reason in the same way as with an auto-detected keyboard.**

- **Note that if you have additional remote control surface devices in your setup, these might have to be added in the Preferences - see “Adding a specific Control surface”.**
  The Setup Wizard will only establish a connected Master Keyboard device.

Setup is now complete!

If all went well, you should now have established audio and MIDI communication - the basics needed to record and play back audio and for controlling Reason via MIDI!

However, if for any reason the Setup Wizard failed to establish the necessary settings, or if you wish to add other devices etc., you will have to make your settings in the Preferences dialog (see below).

- **At the first program launch, you will also have the option to download additional content from the Manage Content window.**
  The optional content consists of Rack Extensions and sound banks and is stored in the “Propellerhead Content” folder in the “Music” folder on your computer. After the download you will have to restart Reason for the optional content to become available.
# About the Preferences

The basic settings for audio and MIDI are done in the Preferences dialog. This is opened from the Edit menu (or, if you are running macOS, from the Reason menu).

![Preferences dialog]

- Described herein are only the most important settings in the Preferences. For information about other Preferences settings, see the “Menu and Dialog Reference” chapter in the Reason Operation Manual pdf.
Setting up the Audio Hardware

In case this wasn't done in the Setup Wizard, you need to establish a connection between Reason and the audio hardware. This is done by selecting a driver - a software component that acts like a link between the program and the audio hardware. Proceed as follows:

1. **In the Preferences dialog, click the Audio tab.**

   - Preferences dialog showing settings for audio card driver, sample rate, buffer size, input latency, output latency, recording latency compensation, active input/output channels, and clock source.

2. **Pull down the Audio card driver pop-up menu and select one of the available drivers.**
   Which driver to select depends on the platform and the audio hardware. If an option is not applicable to your setup it will be disabled in the dialog.
macOS

- Select the option that corresponds to the hardware you want to use (the built-in audio connectors or some additional audio hardware that you have installed).

- A number of predefined combinations of built-in inputs and outputs will also be available in the Audio Card Driver pop-up.

  The number of available input(s)+output(s) combinations depends on your computer’s specific audio hardware configuration.

Windows

- If you run Reason under Windows, it's required that the audio hardware supports ASIO drivers, otherwise you won't be able to record any audio.

- Select the option that corresponds to the ASIO hardware you want to use.

  If you are using audio hardware for which there is a specific ASIO driver, you should select this. With an ASIO driver written specifically for the audio hardware, Reason can communicate more or less directly with the audio hardware. The benefits are lower latency (see below) and possibly better support for additional hardware features such as multiple inputs and outputs.

About Latency and other Audio Settings

On the Audio tab, you will find a number of additional settings for audio. The most important ones are Buffer Size and the corresponding readouts for Input and Output Latency.

The Input Latency is the delay between when the audio is “sent” from a connected microphone or instrument and when it’s received and detected by Reason. Output Latency is the delay between when audio is “sent” from Reason and when you actually hear it. The latencies in an audio system depend on your audio hardware, its drivers and their settings.

When you select a driver, its latency values are automatically reported by the audio card and displayed in the on the Audio tab in Preferences. Depending on the audio hardware and the driver, you may be able to adjust these values. If you experience high latency values, you will need to make adjustments to your configuration.

- If available, use the Buffer Size slider to lower the latency.

  The lowest buffer size setting you can choose depends on the audio drivers and your computer’s performance. If you get crackles and glitches during playback, the buffer size is set too low for your system - you need to raise the buffer size until you can play back normally.

- If the Buffer Size slider is disabled, you may be able to lower the buffer size in the control panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the Reason Operation Manual pdf.
Setting up MIDI Control Surfaces

In Reason, MIDI keyboards or remote control devices are called control surfaces. MIDI input from control surfaces can be handled by two systems: “Easy MIDI Inputs” and Remote. Here are some of the main features:

• **You can use any number of control surfaces at the same time.**
• **The program supports a large number of control surfaces out of the box - knobs, faders and buttons on the surfaces are automatically mapped to the most useful parameters on the Reason devices.**
  You don’t have to change the settings on the control surface to control different devices in Reason - if you change MIDI input from a ID-8 track to a Combinator track, the control surface will automatically adapt. You just set up your control surface once and for all for use with Reason - the program handles the rest!
• **For control surfaces that are not natively supported at this stage, you can use generic drivers.**
  Note however, that Remote drivers for additional control surfaces will be added continuously - check our web page for more info.
• **By default, all control surfaces follow the sequencer Master Keyboard Input.**
  This means that you set MIDI input to a track in the sequencer to route the control surface(s) to the track’s device in the rack.
• **You can lock a control surface to a specific device in the rack.**
  For example, you could have a Master Keyboard that follows MIDI input, while another control surface is locked to the Main Mixer. This way you can control levels and pans at all times. This is described in the Operation Manual.
• **You can use remote overrides to map a specific control on a surface to a specific Reason parameter or function.**
  For example, you could override-map a knob or fader on your control surface to the Main Mixer’s master level fader. Or you could map buttons on your control surface to control Reason’s transport (play, stop, record, etc.) at all times, regardless of which track has Master Keyboard Input in the sequencer. This is described in the Operation Manual.
• **Remote also supports some control surfaces with MIDI feedback.**
  If you have such a control surface and it is supported by Reason, you can take full advantage of motorized faders, meters, displays, etc.

In case you specified a Master Keyboard in the Setup Wizard, and you don’t have any other control surfaces, you don’t have to do anything else. But if you want to add additional control surfaces or edit your settings, this is done in the Preferences.

**Automatic set-up using the Easy MIDI Inputs function**

By default Reason automatically scans and detects all available MIDI In port(s) on your computer. If you have a MIDI keyboard or MIDI control surface connected to your computer, Reason automatically connects and lets you use it for controlling Reason. This way you don’t have to do any manual set-up but can start controlling Reason right away.
At the bottom of the Control Surfaces tab in Preferences all currently available MIDI In Ports are listed:

- The Easy MIDI Inputs function supports input of MIDI Note On/Off (with Velocity) as well as standard performance controllers, such as Mod Wheel, Pitch Bend and Sustain Pedal. You can also do manual Remote Overrides to assign Reason parameters to knobs/sliders/buttons on your control keyboard/surface. See the Remote chapter in the Operation Manual for more information.

- Deselect the Enabled box(es) to disable MIDI Ports you don't want to be available for Reason. For example, if you have a drum machine connected via USB to your computer, you might not want it to start sending MIDI Note data to Reason, especially if it's synced to MIDI Clock to Reason's sequencer.

Adding a specific Control surface

If your specific MIDI keyboard/control surface model is featured in the list of supported surfaces in Reason you will get even more functionality if you add it in the “Remote keyboards and control surfaces” section at the top - with knobs/sliders/buttons already pre-assigned to parameters in Reason.
1. Open the Preferences dialog and click the Control surfaces tab.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connection), try clicking the Auto-detect Surfaces button.
   Reason sends an ID request to all MIDI ports and checks for answers from any connected control surfaces. Note that not all control surfaces support auto-detection.

   ! If a MIDI Port of your connected control surface/keyboard is already used by the Easy MIDI Inputs function (see “Automatic set-up using the Easy MIDI Inputs function”), this detection will override this and automatically remove the MIDI In Port from the Easy MIDI Inputs list.

3. To add a control surface manually, click the “Add manually” button.
   This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
   If you can’t find it on the menu, see below.

All found surfaces are listed in the “Remote keyboards and control surfaces” list.
5. **Select the model of your control surface from the Model pop-up menu.**
   If you can't find it on the menu, see below.

6. **An image of the selected control surface model is shown, often along with some information text - read this carefully.**
   For some control surfaces, you need to select a specific preset to use the surface with Reason - this is noted here.

7. **Use the MIDI Input pop-up to select the input port to which you have connected the surface.**
   If in doubt, you can click the Find button and then tweak a control or play a key on the control surface to have Reason find the correct input port for you.
   - **Some control surfaces may have more than one MIDI Input pop-up menu.**
     You need to select ports on all MIDI Input pop-up menus.
   - **Some control surfaces will have a MIDI Output pop-up menu.**
     In some cases this labeled "Optional" - then you don't have to make a selection. In other cases, a MIDI Output is required. This is the case if the control surface uses MIDI feedback - motor fader, displays, etc.

8. **If you like, you can rename your control surface in the Name field.**

9. **Click OK to add the surface.**
   - **Depending on the surface model, alerts may appear, reminding you to select a specific preset etc.**
     In some cases, Reason can restore a preset in the control surface to factory settings for you - you are then informed of this.

Finally you return to the Control Surfaces tab in Preferences, where your added surface is now listed.
If your control surface model isn't listed

If you can’t find your control surface listed on the Manufacturer or Model pop-up menus when you try to add it, this means that there’s no native support for that model. However, the program supports generic keyboards and controllers. Here’s what to do:

- **Select "Other" on the Manufacturer pop-up menu and then select one of the three options on the Model pop-up menu.**

Or, if the Manufacturer is listed but not your specific model:

- **Select one of the three "Other" options on the Model pop-up menu:**

In both cases, the options are:

- **MIDI Control Keyboard**
  Select this if you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set up your MIDI control keyboard so that the controllers send the correct MIDI CC messages, depending on which Reason device you want to control - check out the MIDI Implementation Chart in the Reason documentation. If your control surface has templates or presets for different Reason devices, these can be used.

- **MIDI Control Surface**
  Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without keyboard). Again, you need to set your controllers to send the correct MIDI CCs.

- **MIDI Keyboard (No Controls)**
  Select this if you have a MIDI keyboard without programmable knobs, buttons or faders. This is used for playing only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot adjust Reason device parameters with this type of control surface.

- **MIDI Multichannel Control Keyboard/Surface**
  These options can be used if your MIDI keyboard or surface can handle multiple MIDI channels simultaneously.

After selecting a model, proceed with selecting MIDI input as described above.

**About the Master Keyboard**

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must have a keyboard and it cannot be locked to a specific Reason device (in other words, it always follows the MIDI input to the sequencer). This is the surface you use to play the instrument devices in Reason.

- **The first surface with a keyboard that is added (or found by auto-detect) is automatically selected to be the Master Keyboard.**
  This is shown in the Attached Surfaces list on the Preferences page.

- **If you want to use another surface as Master Keyboard, select it in the list and click the "Make Master Keyboard" button.**
  You can only have one Master Keyboard.

- **If you don't want to use any Master Keyboard at all, select the current Master Keyboard surface and click the same button (which is now labeled "Use No Master Keyboard").**
Master Keyboard Input

This allows you to set a preference for how Master Keyboard Input mode is selected:

- **Standard mode**
  This always sets Master Keyboard Input to the selected track.

- **Separated mode**
  This will allow you to independently select tracks while Master Keyboard Input is unchanged. When this mode is active, Master Keyboard Input is set by clicking the device icon in the track list. Selecting another track (by clicking on the track name or somewhere in the track list), leaves Master Keyboard Input unchanged.

**Other functions**

- **To edit a surface, double-click it in the list (or select it and click Edit).**
  This lets you change its name and MIDI port settings, if needed.

- **To delete a surface, select it in the list and click Delete.**

- **You can turn off a surface by deactivate its “Use with Reason“ checkbox.**
  This could be useful if the surface is connected to your system but you only want to use it with another program, etc.

- **There is also a “Sync” page in the Preferences.**
  This is only used for External Control MIDI buses and for MIDI Clock Sync. All hands-on MIDI control is set up on the Control surfaces page.
Setting up the Default Song

It’s possible to select a default Song which will automatically open as a “template” each time you select “New” from the File menu. The Default Song could be any Song you have created earlier, or a factory made Template Song. You can select this Default Song on the General tab in Preferences.

1. Select “Preferences” from the Edit menu (Win) or “Reason“ menu (Mac) and then click the General tab.

2. Click the "Template" radio button in the "Default Song" section.

3. Click the folder icon to the right and select the Song you want to use as template when creating new Songs.

Each time you create a new Song (by selecting "New" from the File menu), the selected Song will be loaded and used as a template for your new Song. On Windows platforms, the Song document will be named "Document n" where "n" is an incremental number. On macOS platforms, the document will be named "untitled n" where "n" is an incremental number. You can then save your Song with a new name.

Opening the last Song at program launch

It’s possible to instruct Reason to automatically open the last Song each time you launch Reason. You select this on the General tab in the Preferences dialog.

1. Select “Preferences” from the Edit menu (Win) or "Reason" menu (Mac) and then click the General tab.

2. Tick the "Load Last Song On Startup" checkbox.

When you launch Reason the next time, the last saved Song will automatically open in a document window.
Reassigning the Function Keys in macOS

When you work with Reason, you will do a lot of navigating between the three main areas - the main mixer, the rack and the sequencer. The quickest way to switch between these areas is to use the function keys F5, F6 and F7 (see “Navigating between the areas” in the “Common Operations and Concepts” chapter in the Operation Manual and Help system for details). Also, the F2, F3, F4 and F8 keys are shortcuts for showing and hiding the Spectrum EQ window, Browser, On-screen Piano Keys window and the Tool Window, respectively.

However, on many Macintosh models (especially MacBooks), the function keys double as hardware control buttons. For example, they might control the volume of the built-in speaker, the display brightness or keyboard backlight. To make these keys actually work as function keys for software such as Reason, you need to hold the "Fn" key while pressing them.

This can work perfectly OK, but to get the best workflow in Reason we recommend that you change this behavior, so that pressing e.g. the F5 key actually sends "F5" to Reason (and you hold down the Fn key to get the hardware control functions instead). Here is how you change this:

1. **Open the System Preferences in macOS and select the "Keyboard" item.**
   The "Keyboard" preferences are shown.

2. **Select the "Keyboard" tab and make sure the checkbox "Use all F1, F2, etc. keys as standard function keys" is ticked.**
   Now you can use F2-F8 for controlling functions in Reason. To use hardware control features such as volume and display brightness, you need to hold down the "Fn" key before pressing the function keys.

Some function keys might also be pre-assigned to macOS keyboard shortcuts, which will have priority over software such as Reason. This is easily changed:

3. **Click the “Keyboard Shortcuts” tab in the “Keyboard” window.**
   The Keyboards Shortcuts Preferences window shows lists of keyboard shortcuts assigned to system functions. For example, [Cmd]-[F5] in the Accessibility group is assigned to turn VoiceOver on or off. In Reason, this is the keyboard shortcut for detaching the main mixer into a separate window.
4. Scroll down to the "Turn VoiceOver on or off" item in the Accessibility group and either remove the tick from the checkbox or assign it to another keyboard shortcut.

5. Now, you're finished with the settings and can close the “Keyboard” window. From now on, the function keys and keyboard shortcuts will perform their intended functions in Reason.